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From The Editor’s Desk

PhotographyBB Online Magazine Sixth Edition - Bring on Lightroom!

Can you believe that its been six months already? It seems like just yesterday I was 
sitting down at my computer, trying to figure out just exactly what I had gotten myself 
into, and how we were going to put together a great, informative, and better yet FREE 

magazine! It’s amazing how time flies because here we are at our sixth month anniversary, and 
the magazine keeps growing bigger and better with each issue. As always, I would like to give 
credit where credit is due. I don’t just produce this magazine on my own; I do it with the help 
of a very dedicated core group of volunteers, along with some fabulous guest contributors in 
each and every issue. Thank you all for getting us to this point; it looks like the sky is the limit!

So what do we have in store for you this month? As always, our good friend and colleague 
Kenneth Fagan has done a remarkable job, bringing us a brand new multi-part series on 
building and working within your own darkroom. In addition, Ken continues his tradition of 
helping the beginners figure out their SLR cameras with our Photography 101 series, and also 
gives us a great look at Australia with gorgeous photos and witty commentary.

Victoria Sargsyan has been hard at work, giving us two great tutorials for Dreamweaver® 
and Photoshop Elements®. Thank you Victoria for all of the hard work that you put into the 
magazine and your contributions to the forums. Victoria just happens to be in second place in 
our Top Ten Posters list on the forums, with Ken Fagan in a close third place!

Jon Ayres contributed what I consider to be one of his best articles to date so far, giving us 
a look at the classic art of black and white photography. Jon always puts a lot of thought and 
passion into his articles, which I believe, are they keys to his success and contributions.

We also have two new guest contributors this month: Rob Davidson from Australia gives us 
a look at panoramic photography techniques, teaching and inspiring all of us to try something 
new if we’ve never done panoramics before. I am also excited to welcome John Ogden to this 
issue. This month, John gives us a great look at how we can use Adobe Photoshop® Lightroom™ 
to achieve creative photographic effects without the use of Photoshop®. 

Last but certainly not least, Fred McWilson (the OOB and HDR guy!) continues our series 
on HDR (High Dynamic Range) photography techniques, this time, showing us how to set up 
our cameras and take the proper photos before we step into HDR processing  - which will be 
the topic of next month’s issue.

 I’ve been receiving several emails with very kind and encouraging comments from you, so 
I would like to say thanks to everyone out there who enjoys reading the magazine; we couldn’t 
be doing this without you. Drop me a line anytime, I would love to hear from you.

Dave Seeram
Editor and Publisher

Dave Seeram is the Editor in Chief for PhotographyBB Online Magazine. As 
the administrator of the PhotographyBB Website and Forums, Dave is also 
an experienced author of several Photoshop® Actions and Tutorials which 
can be found on http://www.PhotographyBB.com
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DAVE SEERAM is the creator of the PhotographyBB Online 
Website, and the Administrator of the PhotographyBB Forums. 
Dave is a digital photography enthusiast, and loves shooting 
landscapes and architecture in his spare time. Additionally, he 
has several years of formal training in both Adobe Photoshop® 
and Quark Xpress®. 

KENNETH FAGAN is a photographer extraordinaire based in 
Meath, in the Republic of Ireland.  Ken graduated with a profes-
sional Diploma in Photography from the Focal Point School for 
Visual Arts in Vancouver. His specialities are product and food 
photography, but he is also skilled in fashion, sports and land-
scapes. Ken works with many camera formats including, 35mm 
pro digital and film SLRS, medium format, and 4x5 large format. 

JON AYRES is a digital photographer from the United States, 
now living in Moscow since August 2003. He enjoys photogra-
phy, writing, history, and taking beautiful scenes of Moscow on 
his walking photo-tours. Jon has been involved in writing, digi-
tal art and photography for over thirty years and is a published 
author having several articles and photos published. 

VICTORIA SARGSYAN is a professional graphic designer 
from Armenia, now living in the United States. She brings over 
15 years of professional experience in graphic design, and her 
favorite software tool is Adobe Photoshop. Additionally, she 
is experienced in Illustrator, CorelDraw, Freehand, Lightroom, 
Adobe ImageReady, Flash,HTML, Dreamweaver, Motion Artist, 
Anime Studio, Poser.

FRED MCWILSON is a photographer and Photoshop-wizard 
from southeast Missouri. We’re pleased to have Fred with us 
as a Photoshop tutorial and HDR column author. Some of his 
hobbies other than Photoshop and photography are caving 
and paintball. 

GUEST CONTRIBUTORS THIS MONTH: 

Rob Davidson is an Associate Professor and Head of Medical 
Radiations at RMIT University in Melbourne Australia.

John Ogden is an award winning London based digital artist 
and photographer. John lectures on Photoshop CS3 and 
Lightroom to adult learners in Further Education, is an Adobe 
Certified Instructor, and member of NAPP. 
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To start the materials you need are minimal, I have 
listed them below and explained what each is needed 
for in the process.

Developing tank:  This lightproof container houses the 
film and the chemicals during the developing process. 
Each tank (or most) comes complete with at least one 
film spool to hold the film during the process in the 
developing tank. 

Scissors: Necessary to cut the film from the cartridge 
and the sharper the better.

Bottle opener: Useful for opening the film cartridge 
for access to the film

Film: you will need an exposed roll of black and white 
film. However, at the beginning, practice spooling the 
film with some out of date or useless cartridges of 
35mm film of any description.

Changing Bag: A changing bag is a lightproof bag 

with sleeves to allow your hand to work inside the bag. 
You cannot see what you are doing but with practice, it 
becomes second nature. If you do not have a dark bag, 
use a room or a closet with no windows and no light 
leaks. Alternatively, when I started out developing my 
own film I placed a medium sized box on my bed with 
plenty of heavy blankets over it and myself. This was 
a rather primitive (and looking back, quite amusing) 
technique I used, but it worked well, which was all that 
mattered. As long as you are able to work in an area 
with absolutely no light leaks you will be fine.

A developing tank is essential for developing film 
(some people use bowls in a darkroom with the lights 

Before There Was Digital...
Before the days of digital photography and still today, the art of developing 
film has been regarded as a skill in a class of its own. Over the next three 
months, we’ll take a look at the world of darkroom processing in an effort 
to both challenge and inspire those photographers who are willing to try 
something new and have fun in the process!

DARKROOM DELIGHTS: DEVELOPING YOUR OWN BLACK AND WHITE FILM - By Kenneth Fagan

Developing your own film may seem to be a complicated and messy affair. However, in truth, it is quite simple 
and once you get the hang of it, it can be a lot of fun and less daunting than what you may think. I am going to 
introduce to you, the world of darkroom processing in three parts over the next three issues of this magazine. This 
month I am going to teach you the basics of how to develop your own film with minimal fuss, and then you will 
just have to wait and read the next two issues to find out more on setting up your own darkroom and processing 
your own prints. It is all in the name of fun so read on and open up a new chapter in your photography.

Developing Tank with spool and tank components
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off but it is a very messy and awkward process).  Here’s 
a short step-by-step guide for getting the film from its 
cartridge to the spool in a few simple steps

1. Remove the spool from the tank. Get a few rolls 
of old expired 35mm film to practice spooling onto 
the film spool. Use a bottle opener to open the film 
cartridge (you can do this in broad daylight using the 

practice film, do not open any good rolls in any sort 
of light). This is where you start practicing before you 
start anything else. Do not touch the exposed are of 
the film, even though it is an unused roll it is a bad 
habit to get into and fingerprints destroy film. Holding 
the film by its edges, cut the end off the film between 

the sprocket holes and round off the corners on each 
side with out cutting into the holes. This makes it a lot 
easier to guide the film onto the spool. 

2. Guide the film onto the spool where the groove 
meets the outside edge of the spool this can be easily 
identified by the two small notches on either side. 
Feed the film in by gently pulling it through the groove 
for about three or four inches, enough for the small 
bearings to engage the film

3. With the start of the film in the spool and the two 
notches lined up. Hold one side of the spool and 
gently, with forward motion, move the other side; this 
moves the film further into the spool. Moving the one 
side of the film back and forth pushes the film along 
the grooves of the spool. Continue this process until 
the entire length of film is fully inside the spool. 

4. Guessing that you were looking at what you were 
doing the first time. Repeat the above process entirely 
with your eyes closed or in the dark. Keep repeating it 
until you can do it blind. Do not even attempt to spool 
up your good roll of film before you get some practice 
in or you could be kissing your sweet film good bye. 
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It does get frustrating when you cannot seem to get 
the film to spool correctly or it keeps getting stuck but 
you will improve with the more practice you put in. The 
spool seems to know when you are frustrated because 
it never seems to work when you swear at it repeatedly! 
In other words, if something goes wrong remain calm 
and try again.

5. Once you feel you are ready to spool the real deal: 
Set up your developing tank, your opener, the spool, 
the scissors, and the film on a table or similar in 
complete darkness. Make sure you know exactly where 
everything is; it saves a lot of fumbling around feeling 
for stuff. 

6. Remove the film from the cartridge and repeat 
the process of spooling I described earlier for each 
roll of film you want to develop. Take your time and 
remember only handle the film by its edges. Once the 
film has been spooled, cut off the end of the film with 
your scissors.

7. Place the Spool in the empty developing tank with 
the center column that keeps it from moving around 
in the tank.

8. Tighten the lightproof lid back onto the tank and then 
the smaller lid (to cover the holes where the chemicals 
are poured. It is now safe to switch back on the light as 
the developing tank is completely light tight. 

Once you have the film safely inside the developing 
tank you are ready for the next step in the developing 
process. For this, you will need the following:

Thermometer: The temperature of the chemicals used 
is quite important so a thermometer is a tool which no 
dark roomer can be done without. (I usually develop 
film at 21ºC)

Film Developer: This is the first chemical in the process, 
this is where the image on the negative appears, and 
hence it is developed.

Stop Bath: This chemical neutralizes the developer. 
Once this happens the film ceases development but it 
is still not safe to expose the film to light.

Fixer: The fixer is the final step in the actual developing 
process. Once the stop bath has been removed, the 
fixer is poured in, which is the chemical that allows the 
film to be viewed in daylight without destroying it.

Wetting agent: This is introduced at the beginning of 
the washing stage. It helps prevent watermarking on 
the film and so helps the drying process.

Water: Used to mix the chemicals and wash the film 
before drying.

Measurement Beakers: Use the beakers to measure 
out the correct amount of chemicals.

Funnel: Use the funnel to prevent spills
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This article and photographs contained are Copyright © and courtesy of Kenneth Fagan. Please contact the author directly with any questions.

Begin by setting up all your chemicals in the following 
order; Film developer, Stop Bath, Film Fixer. Each 
chemical will be used in that order. If it is not done in 
that order, you will most definitely destroy your film.
Follow the steps and you have an excellent chance of 
success.

1. You will need a good amount of water to develop 
your film, the simplest way of getting around this is to 
fill around two or three five-litre bottles of water at 21 
ºC. Use your thermometer for this. The temperature 
can be obtained by using a mixture of hot and cold 
water to regulate the temperature.

2. Mix the Developer, Stop Bath and Fixer into three 
separate beakers (plastic bottles or bowls do fine). Do 
not remove the screw on lid on the tank to do this.

3. Begin by pouring in the Developer (as shown - upper 
right image) Check the time guide on the container for 
the developing time of the developer. Agitate the tank 
for the first 30 seconds, and then for 10 seconds after 
every minute, and then gently tap the base of the tank 
to remove any air bubbles on the film.

4. After the developing time is up, immediately pour 
out the developer and pour in the stop bath, the stop 
bath will neutralize the developer. Agitate again for 
the first 30 seconds then every minute for 10 seconds. 
Usually the stop bath will have done its job in under a 
minute, but to be on the safe side leave it in the tank 
for about two or three minutes. In any case, read the 
precautions on the container, as it differs with different 
brands and dilutions.

5. Pour out the stop bath once the allotted time has 
elapsed and pour in the fixer. Using the same agitation 

techniques when you were using the stop bath and 
developer. The fixer allows the film to be exposed to 
light. Do not open the film to the light until about three 
and a half minutes have elapsed. The approximate 
fixation time is normally between five to seven minutes 
depending on the brand and the dilution also.

6. Pour out the fixer. You can open the developing tank 
to take a look, but do not take the film off the spool just 
yet. With the spool still in the tank, fill the tank almost 
to the top with water (at 21 ºC) and add two drops of 
wetting agent (one drop of washing up liquid can be 
used as an alternative) and rotate the spool in the tank 
for about one minute. 

7. Pour out the wetting agent mix and pour in plain 
water and rotate the spool for about half a minute, 
repeat this last step about ten or fifteen times to ensure 
all chemicals etc. are fully washed away. 

8. Once all the above steps are complete, remove the 
film from the spool and hang it in a warm, dry and dust 
free area (as dust free as possible). You can remove 
excess water by using a film squeegee

Now at that stage you should have successfully 
developed your film. Before you do any cutting, 
scanning etc. leave it to dry for around 24 hours. Always 
remember - Never touch the film and only handle by 
the edges.

Please use the images with this tutorial to guide you 
further on developing film for the first time. I hope that 
you enjoy the magic of black and white photography. 
Developing your own film can be very fulfilling and 
you will feel like a more accomplished photographer 
when you have tried it.

Safety Precautions:
When using chemicals, keep them well away from children of all ages. Chemicals should be stored away from food 
and drink. Always wash your hands after the use of chemicals and wear a mask if you are sensitive to strong smells 
or fumes. Seek a doctor’s advice immediately if you have or think you have swallowed chemicals or were splashed in 
the eyes with it. Always read the warnings and instructions on the chemical containers before using.
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Black & White

Are you tired of shooting the same old 
same old? Think you have run out of 
things to photograph? Maybe you’re 

looking for some excitement, dynamic, bold 
photographs instead of your same old so-
so photos? Why not give black and white 
photography a try?  You could very well be 
in for a huge surprise and may find that you 
actually have more talent than you ever 
realized before.  Many hobby photographers 
today seem to have forgotten all about 
black and white photography, even though 
there now is something of resurgence in the 
popularity of black and white photography.  
Just tonight I was reading a post on one of 
the photography forums which the poster 
asked if photographers felt that black and 
white photography was coming to an 
end.  Though this was a film photography 
forum, a lot that was said could also apply to 
digital photography.  That black and white 
photography is now and has always been 
the strongest form of fine art photography 
from the very beginning of photography; this 
is true in both film and digital photography.  
Black and white photography has always 
been considered classic, glamorous, 
powerful and even mysterious.  Black-and-
white has remained a specialized market 
for photographers who use this medium for 
artistic reasons.  

The first cameras made in the mid 1800’s 
only took black and white photos, then 
personal cameras could take color photos in 
the 1950’s, but color photos were some what 
considered gimmicky by most pros until the 
late 1960’s.  It was then that black-and-white 
photography was considered old fashion 
and somewhat out of style by many amateur 
hobby photographers, after all Hollywood 
was shooting movies in color along with a few 
TV shows.  But a few well known professional 
fine art photographers decided that color 
just lacked something and stayed with black 

and white.  Now, some photographers are 
rediscovering the beauty of black-and-white, 
and many of the top digital art photographers 
only shoot in black and white. So, we are able 
to admire the power and purity that black-
and-white images offer to the viewer.  Good 
black and white images show emotions, 
classicism, strength, weakness, purity, peace, 
calmness, hatred, love or romance.  Just look 
at any of the major business magazines. 
Why do you think most company CEOs and 
Executives choose for their portraits to be 
shot in black and white? - Because it shows 
power and class.   Good black and white prints 
exhibit a refined quality. Their simplicity and 
uncluttered look give the subject well defined, 
polished, high-class feelings to them. Color 
photos tend to sometimes have distractions, 

The Classic Photography Art - By Jon D. Ayres

This photo was just begging to be done in black and white, it 
is one of my favorite photos taken in a cemetery in Moscow.  
The color version was good, but the black and white version  
sets the mood of this photo just perfectly.
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whereas black and white photos exhibit to each viewer 
the individuality and specialty of the photographed 
subject.  Take a look at advertisements in a magazine 
sometime; which products are in black and white and 
which are in color, I think you’ll find that the products 
trying to say, “we have class” the most expensive luxury 
items are a lot of time done in black and white, because 
black and white represents a style of class which sets 
them apart from the rest. 

Brides love black and white photography because 
it strongly exemplifies romance.  They are fully aware 
that there is something special about photos done 
in black and white that really captures the mood and 
expressions of that moment. Good black and white 
photos exhibit class, style and other emotions as 
needed like romance is strongly shown in an excellent 
B&W wedding photo.  Think about the romantic black 
and white movies done in Hollywood in the 1930’s, 
40’s and 50’s and the black and white photographs of 
the movie stars, how glamorous and romantic those 
photos of actresses were and how manly, powerful and 
strong photos of actors were.  Do not make the mistake 
of thinking that these celebrity photos were taken 
in black and white because there were no color film 
at that time; there was color film, but only black and 
white photos expressed the feelings and set the mood 
that the publicity departments wanted the public 
to feel about the celebrities.  Think of the romantic 
images done by Eisenstaedt of a sailor kissing a nurse, 

or Doisneau’s romantic photo of a couple kissing close 
to a French hotel.  Photos like these remain great 
sellers for many years because they strongly define 
and express romance.

 Have you ever noticed how good quality black and 
white photos tend to stand out?  Good classic black 
and white photos are dynamic, bold, strong photos 
that draw the viewer back to the photo over and over 
again.  Take a good look at how often people change 
the photos hanging on their walls, I bet you’ll notice 
that black and white photos tend to have a permanent 
place on the wall while color photos tend to be replaced 
more often.  Yet few hobby digital photographers 
today bother with black and white photography and 
that is just a big mistake in my opinion.  Good black 
and white photos exhibit instant appeal.  Black-and-
white photography has become increasingly popular 
once again, but the problem is there is a big difference 
between what we believe to be good and what truly is 
good.  Just like in any art, you have to be skilled in what 
you are doing or fall flat on your face.  I mention this in 
more detail towards the end of my article.  Compare 
two photos exactly the same except one is color 
and one is black and white.  The exact same photos 
except the black and white one will in most cases look 
uncluttered and stronger.  A lot of dull color photos all 
of a sudden become dynamic when done as black and 
white photos. 

People and portraitures are always great in black and white, B&W 
magnifies the subject’s qualities, that is why most celebrity photos are 
done in black and white.  This is a photo of one of the students of one of 
the schools I teach at, isn’t she charming?

Architecture is another of my favorite black and white subjects, just 
look at how striking this old church is, black and white tends to have 
something of a 3d look I think.
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Just why should you consider shooting black 
and white photos, or more correctly, why should you 
consider post processing your color photos as black 
and white photos, you may be asking? (I’m talking 
color photos shot to be intentionally used as black and 
whites)

1.  Black and white photography is becoming more 
accepted and popular with the general public, 
and that will open up new opportunities for good 
photographers.  This is especially true if you’re a digital 
fine art photographer.  Black and white photography 
has always been popular, just look at the number of 
professional photographers like Ansel Adams who did 
the majority of his work in black and white.  Newspapers 
generally are only interested in high quality black and 
white photos and you’ll be surprised at the demand 
for good gallery quality black and white photography. 
Black and white photos will never go out of style, their 
class is timeless, but they must be good photos. 

2.  In some situations, black and white photography 

will make your photos look more like works of art - 
fine art images that sell in expensive galleries.  First, 
you have to realize that not every photo will look good 
as a black and white photo (this can not be stressed 
enough), which is one of the reasons I only shoot color 
photos and then in post processing convert the photo 
I intended to be black and white.  But just because I 
shoot in color does not mean that when I shoot, I’m 
not thinking in B&W.  I have several reasons why I do 
not let the camera convert the photo into black and 
white.  By shooting in color, I have more options open 
to me.  I never have really been satisfied with how the 
camera converts a photo to black and white; plus I have 
more options with converting the photo to black and 
white in post processing than letting the camera do it.  
Why not have the best of both worlds as a possibility?  
By shooting in color and then converting with post 
processing, I have both a color photo and black and 
white photo done in post processing, then if black 
and white does not suit the photo, then I still have the 
color copy.  Those who say digital photos and post 
processing are “fake photography” are as silly as some 

Street scenes can make for some great B&W photography, in this scene I tried to reminisce with this photo of an old tram car on Arbat Street in Moscow.  
I wanted something of a dreamy look with this photo, is it true that we all only dream in black and white?
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so-called pros who say because 
everybody has a digital camera, 
I’m going out of business.  Digital 
photography and post processing 
is true photography.  If you can 
offer a unique and quality product, 
you will always be in demand.  

3.  The best subjects for black and 
white photos have high contrast. 
There should be a big difference 
between the light and dark areas 
of what you want to photograph.  
How you use light and shadow will 
determine if your photo is a hit or 
miss.  If you are using a color photo 
with no contrast, you end up with 
just a photo that has had its color 
removed and nothing more.  Your 
photo needs to have high contrast 
first for converting to black and 
white.  One of the elements that 
can give interest to a black and 
white shot is contrast.  Contrast is 
to black and white photos as color 
is to color photos.  When shooting 
landscapes, always look for active 
skies, clean featureless skies just 
do not photograph well in black 
and white, with one exception, 
grey cloudless days.  Shooting 
grey rainy landscapes in black and 
white can often times bring out 
hidden features in the sky.  Unlike 
when shooting color, where you 
should have the sun behind you, 
with black and white photography 
it’s generally best to shoot facing 
the sun.  Shadows are important in 
black and white photography and 
when the sun is behind you, it’s 
much harder to achieve the higher 
contrast you need in black and white photography.  
I often see on various photography forums where 
photographers complain about not being able to get 
out and photograph because of bad colorless overcast 
days with little contrast found in grey skies; that’s the 
perfect time for black and white photographers.   Many 
digital photographers actually prefer to shoot images 
for black and white in low contrast situations. So, dark 
and overcast days can provide great opportunities to 
shoot outdoor pictures.  

4.  Images, sometimes landscapes, do not always have 
impact when shot in color.  Converting the photo to 
black and white will many times make a dull photo 
into a dynamic exciting photo.  Remember, sometimes 

a photo is shot because of the color and sometimes 
a photo is shot specifically for B&W; never confuse 
the two.  A photo of a sunset is taken because of the 
striking colors.  I have heard some photographers say 
that they rescue bad color photos by converting to 
B&W and that is fine, but you should know beforehand 
why you are taking the photo and what you’re going 
to do with it before taking the photo.  Photos taken 
specifically for black and white, generally, are always 
better than color photos converted to B&W.  However, 
there always are exceptions to every rule.  Learn how 
to see in black and white.  The best time to shoot black 
and white photos is usually mid day because of the 
strong light and shadows; even photos taken facing the 
sun can provide wonderful results.  Learn how to use 

Night architecture is great for B&W photography, everything is clean and clear, you can even see 
the security cameras of the Kremlin on Spasskaya Tower.  Your eyes are drawn right to the main 
interest.
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different angles of light for different effects.  The major 
difference between color photography and black and 
white photography is how you see your subject; black 
and white photography is creative photography at its 
fullest. 
5.  A black and white photo relies mainly on structure, 
tonal range, contrast, composition and form. If there are 
little of any of these elements, then you have nothing 
left but a weak and dull black and white lifeless photo. 
With a color photo you could frequently get away 
without the having this but you can not with black and 
white photography. Texture is even more important in 
black and white photography simply because texture 
defines shadows and a variety of different types of 
lines found throughout the scene. A feel of what will be 
much more detailed than a smooth cloudless blue sky. 
A good definition of black and white is the capturing 
of a sense of the dramatic. Textures such as wood 
grain, metal, grass, water and the various repeated 
patterns in nature, like waves or spirals, seem to work 
well in black and white photography.  With black and 
white, always try to keep some order in your texture. 
Symmetrical textures in black and white are always 
strikingly lovely.

6.  Just what subjects make for a good black and white 
photograph?  Many subjects are just made for black 
and white photography; people are one of the best 
subjects for black and white photography, especially 
portraitures.  Black and white photos express and 
create a mood and that is one of the reasons black 
and white photos are favorite for weddings because 
they show and express romance in a way that most 
color photos can not.  Black and white photographs 
of a couple on their honeymoon - Nothing could 
reflect such strong emotions as black and white 
photography.  Even photos taken on vacation can 
be just as captivating. Whereas a color picture would 
only be a record of a trip forgotten in a box or album, 
a good black and white photograph always captures 
emotions and impressions in a strong way.  Black-and-
white photographs of children and babies are always 
special and sentimental.  The nostalgic feelings that 
black and white photographs create are always strong;  
Just look at the photos taken of you when you were 
a child, if you’re my age then most photos were only 
black and white.  Portraits are especially good when 
done in black and white, expressing strength, dreams, 
glamour, and power and of course femininity and 
masculinity.  Sometimes a scene will beg to be shot 
in black and white.  You generally can recognize such 
shots with little trouble; an old church, ruins, a certain 
street scene, a statue, and the old black and white 
favorite, an old graveyard.  Of course any scene can be 
shot in black and white, but once you learn how to see 
in black and white, you will spot the scenes that are 
begging to be shot in black and white without much 

trouble.  Its photos like these that galleries are begging 
for. 

Learn to see in black and white.  The main theme 
some photographers and film makers discuss is the 
ability of ’seeing in black and white.’  It makes no 
difference whether they are shooting in black and white 
or color; the ability to see in black and white is one of 
the most useful skills the photographer can learn. If you 
are able to ignore color, you can tell whether an image 
will work or not when converted to or taken in black 
and white.  Should I shoot in black and white or should 
I post process my photos into black and white?  Post 
processing is to digital photography what a chemical 
darkroom is to film.  I am a photographer who believes 
in making my own rules and I enjoy experimenting with 
settings, compositions, and post processing in different 
ways; to me that is apart of the art called photography.  
Never be afraid to try new things or take a risk of a shot 
coming out bad.  It is only the lazy photographer who 
can not think for themselves.  I personally do not like 
using the camera’s black and white mode; I want to 
have complete control over it along with more options 
that post processing gives me.  I may shoot in color, 
but see in black and white when I need to and this 
offers more options to me for creating my art.  A lot 
of the same techniques used in color photography are 
the same in black and white photography, rules, the 
same settings, compositions, views, prospective, even 
if you are using the camera’s black and white mode.  
I choose to shoot in color, then convert to black and 
white with post processing because it offers me more 
control and more options over the outcome of the 
photo, plus I like having an extra color copy to try out 
different things.  I’m a firm believer in experimentation 
in photography and trying out different things.  Black 
and white photography can open up a new world of 
photography for you to get some really impressive 
dramatic photos that speak loudly.  Remember that art 
is subjective, not everybody will like your work, but all 
it takes is one person to like the photo to make it into 
a good photo. 

Something old, something new… The old is black 
and white photography, it’s been around since the first 
photo was taken, and the new is black and white HDR 
photography.  Black and white HDR can really make for 
some very impressive photos.  Take a look at an article 
Jim Austin wrote and his black and white HDR photos.  
These photos are really very impressive and the article 
is very good with excellent directions and workflow 
for creating black and white HDR, The Beauty of Black-
and-White HDR: HDR, For the Love of Light: 
http://www.apogeephoto.com/june2007/
jaustin62007.shtml   

This man’s black and white HDR photos are so crisp 



Pa
ge

 13

PhotographyBB Online Magazine

and clean, it really puts a lot of the color HDR photos 
I’ve seen posted to shame.  This man is a true artist, 
could it be he secretly works in Hollywood?  If you want 
to take a look at some very impressive HDR photos, 
take a look at the link.

Another type of black and white photography that 
I am fond of is a photograph that is converted to black 
and white, except for one part of the photo which 
remains as color; usually a small section of the photo 

or object.  Some of these types of photos can come 
out very well if the right object is chosen to remain as 
color. 

So if you think you have run out of things to 
photograph, give black and white photography a try.  
If your interested in reading a good book or two on 
black and white photography, then you may wish to 
give these two some consideration:

Black and White in Photoshop CS3 and Photoshop 
Lightroom - by Leslie Alsheimer with Bryan O’Neil 
Hughes.  A very good book if you use Photoshop or 
Lightroom to take your photos in color (like I do) and 
then convert them to black and white.

Creative Black and White Photography-Advanced 
Camera and Darkroom Techniques -  by Bernhard 
J. Suess.  One of the best books on black and white 
photography there is in my opinion.  A great book for 
those looking to take gallery quality digital art black 
and white photographs.

Practice your black and white photography using 
the tips I mentioned, because next month, we’re going 
to look at the art of black and white portraitures.

A Word From the Author:

My name is Jon D.  Ayres and I’m originally from 
Albany, GA in the US.  I first came to Moscow, 
Russia in August 2003 and fell in love with the 
city and I have been here ever since.   In Moscow, 
I have taught English, business, history, literature 
among other things.  

I have been involved in writing, digital art and 
photography for over thirty years and I am a 
published author of several articles and photos. 
You can find examples of my digital art and 
photography at the following sites:

http://www.redbubble.com/people/bossman

http://www.featurepics.com/Authors/
Images6269.aspx

http://www.eyeoftheart.com/JonAyres  

http://s28.photobucket.com/albums/c226/
wummis/

http://www.fotothing.com/JohnnyReb/

This article and all photographs contained are Copyright © and courtesy of Jon Ayres. Please contact the author directly with any questions.

Street portraiture, who’s shooting who, notice how B&W magnifies the 
lovely qualities of this young Moscow street photographer, you can even 
see the breeze blowing through her hair, you can even see the smile she 
had when she noticed me photographing her.
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Photography 101
Each issue of PhotographyBB Online Magazine will bring you helpful tips and 
tutorials on how to get the most of your digital camera and equipment. We’ll 
cover camera techniques, principals of photography, digital photography 
issues, and how to get the most from the dreaded manual-mode! 

Many photographers, especially when they 
are just starting out, reach a stage in there 
abilities where it seems impossible to 

improve any further. So if you feel like you are one of 
these people, you are not alone. Trying to achieve a 
composition which justifies and accentuates beauty 
is not something too easily achieved. With a little bit 
of practice your ability to create aesthetically pleasing 
landscape images is just a click away. 

To begin, I suggest that you use a tripod or a 
monopod for shooting landscapes; the reason being is 

that using filters, small apertures and low ISO ratings 
can slow your shutter speed considerably, leaving your 
photos vulnerable to camera shake. Otherwise, as long 
as you stay within your shutter speed comfort zone 
of around 1/90th or 1/125th sec .handholding will be 
perfectly fine. You may often find yourself having to 
compromise apertures and shutter speeds based on 
the light conditions. 

Almost all of the time for landscape photography 
I use my medium format Pentax 645 with a 75mm 
lens. A 75mm lens on a 6x4.5 camera is equivalent to 

THE GREAT OUTDOORS: A PRACTICAL GUIDE TO BETTER LANDSCAPE PHOTOGRAPHY - By Kenneth Fagan

Landscape Photography is possibly one of the most popular subjects of choice for photographers, from the 
complete beginner right through to the seasoned professional. In this months issue, I will give you some easy to 
follow hints, tips, and tricks on how to improve your landscape photography skills.
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approximately 28mm on a 35mm SLR (full frame DSLR). 
If I require a different perspective, I use my DSLR with 
a 24-70mm lens. A cable release is also very useful for 
those longer exposures when your SLR is mounted on 
a tripod particularly for when you use the bulb mode.

When shooting landscapes, as with everything else 
we photograph, it is important to frame the subject in 
a manner that creates interest and appeal. All too often 
landscapes shots can appear boring because of some 
simple composition errors while framing the shot. In 
saying this there are few hard and fast rules about how 
you should or should not photograph a landscape. It all 
depends on your style (of course), but always consider 
what would look best and create a wider appeal for 
more than just yourself. There is a simple ‘grid’ system 
known as the rule of thirds which works by dividing the 
frame into nine segments in the foreground, middle 
ground, and background. The rule of thirds is based 
around the golden mean proportion, which is said to 
be the most pleasing ratio to the eye, as it is a known 
fact that images are more pleasing to look at if the 
main subject or focal point of the image is off centre. 

See the examples of the next two images of the 
same scene: The first image has the same main subject 
in the centre and the second image has the main 
subject off center . Notice how the second image draws 

your eye to the whole image and creates more interest, 
where as with the first (centered) image the appeal is 
much less and it draws less attention to itself. 

From those images you will see by simply moving 
the point of focus in the image to the left or right of the 
frame can greatly improve the aesthetic nature of the 
final product. 

Horizon lines can also make or break a photograph. 
Where the horizon appears in an image, is the splitting 
point between the land/sea and sky. It seems to be a 
habit for some photographers to position the horizon 
line right across the centre of an image. When you split 
an image right across the centre you lose the benefits 
of the rule of thirds. This is not to say that you must stick 
rigidly to the rule of thirds, but it does help. Whenever 
I see a horizon line across the centre, it always reminds 
me of a sheet of paper with a fold line, fold the page 
over and you lose half the image. The same goes in most 
cases for landscape photography, place the horizon 
across the centre you loose most of the aesthetics that 
the scene has to offer. This is just my opinion; If you 
like your images with a centre line go right ahead and 
shoot them that way but do experiment on raising or 
lowering your horizon lines and see which one you 
prefer. Remember that it is not necessarily what you 
like but what your audience likes.

Horizon Centered.
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Once you have composed the shot in your SLR the 
next thing you have to work out is the exposure. Using 
a handheld light meter would be quite beneficial for 
correct exposure, but if you do not have one to avail of, 
you can use the in-camera meter as normal. On overcast 
days you do not have to worry about shadows, as the 
clouds act like one giant soft box, which diffuses the 
light, where as on sunny days you have to deal with 
other issues such as shadows and highlighted areas. I 
recommend for landscape photography that you use a 
circular polarizer or a neutral density filter, or in some 
cases you may need to use both together. Polarizer’s 
reduce glare and unsightly highlights, but they can 
greatly reduce the shutter speed and aperture on 
average by two stops. You can use polarizer’s or ND 
filters on overcast days as well as sunny days. A sky 
covered in a thick blanket of cloud can appear flat and 
over exposed, but with the use of a filter as described, 
more shadows and texture can be brought into the 
image. 

The smaller the aperture you use, the more likely 
you are to get a nice blue sky and fluffy textured clouds. 
With smaller apertures you really need to consider the 
shutter speed. If you are using a hand held light meter 
you will need to compensate the shutter speed for the 
filters. If you are metering through your SLR the light 
will be measured according to the filter on the lens 
whereas if using a handheld meter you will have to 
increase the shutter speed shown on the meter by one 
or two stops. Remember to bracket one or two stops 
under and over the given correct exposure. For best 
results if possible try to shoot the scene at an angle 
where the sun is not catching the lens (causing often 
unsightly images). Shooting with the sun behind you 
will light up the main subject without causing shadows 
(which end up under exposed) making sure that your 
own shadow does not end up in the same image. If the 
sun is in front of you when shooting, the main subject 
will more than likely be shadowed, and exposing for 
the shadows may cause the rest of the image to be over 
exposed. By exposing for the shadows (light metering 

off the shadowed areas of an image) you will have 
more detail in the final image. I tend to expose for the 
shadows using a smaller aperture such as f22 or f32, 
which greatly reduces the chances of overexposing 
the brighter areas of a scene such as the sky. In the 
image of the oil jack, the sun was behind me so there 
were no shadows on the subject. Using an aperture of 
f22 at 1/8th and a circular polarizer, the sky and clouds 
kept their natural tones nicely, and the oil jack and the 
ground remained correctly exposed.

Horizon Off-Centered.

Lens flare shown here, from sunlight catching the lens.
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Another aspect of landscape photography to consider is the time of day. Some subjects look better at night than 
during the day. A mountain scene quite often looks more appealing at sunrise or sunset. If possible, on the day you 
are going out on a shoot, be selective on what you photograph at certain times. Of course this may not always be 
possible but a midday sun high in the sky can cause hard shadows. When the sun is lower, it reduces strength and 
the light becomes softer with beautiful orange and magenta tones.

Sometimes a great time to shoot is after a rain shower. It clears the air of dust and gives the scene a fresher, 
cleaner appearance. So don’t be put off by the rain too much, sometimes you can come up with some interesting 
shots in the rain.

Cityscapes are landscapes of the night. When all the lights are lit up, a downtown skyline can be beautiful. 
Have a look at the two cityscapes shown here. The first one is a panorama (three frames) of downtown Vancouver. 
Shooting panoramas by day is quite possible handheld (such as the snowy mountain sunset), but by night a tripod 
and a cable release are the essential tools for a successful panorama. This downtown panorama is made up of three 

frames at an exposure of 20 seconds each (each frame must have the same exposure time and aperture). In the 
second night scene (shown on the following page), the SLR was not mounted on a tripod. I simply rested it on the 
sidewall of a bridge for 16 seconds at f11.

When shooting night cityscapes, the smaller the aperture the greater the starburst effects you will have. The 
starburst effect is caused by the light moving through the diaphragm of the lens (which controls the apertures). 
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The longer the exposure, the more the starburst effect 
will also increase. As can be seen in comparing the 
two cityscapes, the panorama has a greater starburst 
effect because of the smaller aperture and the longer 
exposure.

When shooting landscapes, there are a few 
formats in which you can shoot: Landscape which is 
the standard orientation for landscape photography, 
and portrait which is holding the SLR in a vertical 
orientation to create higher landscape images while 
compromising the amount of a scene you can fit in a 
frame. This can be quite useful for panorama work or if 
you want a ‘Big Sky’ effect.
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An alternative and less commonly used method 
(instead of the landscape or portrait format) is the Dutch 
angle. The Dutch angle is simple tilting the SLR to one 
side to change the perspective of the composition. It 
only works in certain instances and if done correctly it 
can look fantastic, but if it is used in the wrong scene it 
can just look like a big mistake, where the camera was 
held at a bad angle.

It is important not to rush landscape photography; 
like any other photographic discipline it takes time 
to get ‘that shot’. Take your time and work on a few 
different scenes instead of rushing around and trying 
to get as much in as you can without any thought. 
When you do not stop to think about what you would 
like to get out of an image, you will only end up with 
nothing! You should spend more time composing and 
shooting the scene, rather than “fixing” your images in 
Photoshop. It wastes a lot of time and slows the whole 
process completely. Becoming reliant on Photoshop to 
fix your mistakes is time consuming. Striving to become 
a better photographer means that you must learn to 
discipline yourself with time and effort when you are 
actually using your camera. If you want to keep your 
image natural, ninety percent of your work will have 
to be in camera, with only a few normal tweaks such as 
colour correcting in curves, sharpening, and possibly 
cropping. Having to do too much post processing can 
destroy an image beyond use with loss of detail and 

pixilation; not good if you have a client waiting for the 
final piece. 

Remember that the most important aspect of 
landscape photography is the appeal that the photo 
you created has with the people viewing it. Follow the 
simple steps and you will be well on the road to better 
landscape photography. Take your time, be patient, 
and think before you shoot. Have a look through the 
images below to inspire some ideas about getting a 
nicely composed and appealing image.
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This article and photographs contained are Copyright © and courtesy of Kenneth Fagan. Please contact the author directly with any questions.
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Photography Around the World
PhotographyBB Online Magazine is pleased to launch our first issue with a 
fabulous and stunning photo-tour of one of the most fascinating cities in 
the world - Moscow. Jon Ayres takes us on a streetwalking tour of the city, 
with some interesting historical facts and of course, amazing photos!

Photography Around the World
Each month, the PhotographyBB Online Magazine takes you around the 
globe for a fascinating photographic exploration of different lands and 
cultures which enrich our beautiful planet. Join us as we travel the world, 
and become inspired by the photographic glory of far away places.

THINKING BACK TO AUSTRALIA: BUSH HATS, DINGOES AND DIDGERIDOOS  - By Ken Fagan

It has been about six years since I took my first trip 
to the vast expanse that is Australia. I can remember 
it was a cool morning on the fourth day of March. 

There were three of us, my cousin, sister and myself. 
It was my first long haul trip, although it felt more like 
I was embarking on an epic journey of discovery to a 
country which I have always been fascinated since the 
days of Kylie Minogue playing Charlene in the Australian 
soap ‘Neighbours’ in the late eighties. I am not old; I 
was quite young back then but I can remember the 
Neighbours fad quite well still, everyone and their dog 
watched it...even I did!

Many years later Kylie became properly famous 
again and I was about to visit her birthplace, which 
is where the similarities between my trip and the 
aforementioned blonde ended. The flight from Ireland 
to Australia was long - very long in fact. A stop / 
start affair it consisted of a stop in London’s monster 
Heathrow, then twelve hours later, phase two of the 
flight was completed when we landed in Singapore. 
Stupefied by the long flight the few hours leading up 
to phase three, the final leg of the journey has been 
blanked from my memory. Watching the sunrise over 
Sydney as we prepared for landing was its only saving 
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grace; alas, we made it to the land down under. We 
were meeting another cousin out there so altogether 
there was just the four of us.

Obviously (since we landed there) Sydney was our 
first port of call. A beautiful and modern city famous 
the world over for its monumental harbour bridge 
linking the north and the south of the city together. For 
about $100, we scaled it with a guide across the top. It 
was a fun experience, tethered to the railings there was 
no danger of falling or anything of the sort. Another 
well-known marker of Sydney is its boat shaped opera 
house. A truly magnificent feat of engineering, it sits 
proudly on the harbour next to the bridge. We stayed 
in Sydney for the first week of the trip, checking out the 
sites such as the bridge, the opera house, as well as its 
many fine restaurants and fashionable streets. During 
our stay in Sydney, we took a train out to the Blue 
Mountains where we hiked for about four hours up a 
mountain. The views were spectacular from the top. It 
was (and still is) a popular tourist destination because 

of a natural sandstone formation known as the Three 
Sisters due to an old belief of the aboriginals who 
believed that they were; yes, you have guessed it, three 
sisters who were turned to stone. It was a beautiful 
sight of three towering stone spires projecting from a 
distant mountaintop. 

From Sydney we boarded the greyhound and our 
journey continued on to Brisbane, a sprawling city of 
south-west Queensland. From there we headed north 
and took a short ferry so Fraser Island, an unspoilt land 
that is made up of sand dunes bound together by 
towering eucalyptus trees. The still water was crystal 
clear, with streams so clean that one could hardly 
notice the water at a glance. I saw my first Dingo on 
the island too. Dingoes are wild dogs which originated 
from Asia and are thought to be the only pure 
breed Dingoes left in Australia. The mainland being 
occupied buy domestic dog breeds, it was inevitable 
that crossbreeding between the two would occur, 
jeopardizing the welfare of the wild Dingo. We toured 
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around Fraser Island for three days on a Dakar style 
off road bus. Unfortunately, it was wet for the most 
part, which was to be expected since the wet season 
was beckoning since the heady days of summer had 
ended. 

Returning to the mainland, we headed further 
north to Airlie Beach where we stayed for one night. 
The next morning at about seven in the morning, we 
scratched our way out of bed and made our way to the 
town harbour where we had booked a three-day trip 
on a yacht with a group of other tourists (like us) to 

the Whitsunday Islands. I had watched the weather on 
the TV the night before, a huge storm was battering 
the North West coast and rapidly heading south. As the 
day wore on the effects the storm had on the swelling 
sea had deteriorated considerably. Looking back it was 
scary to begin with. I had never sailed before, so my 
worst fear was taking an undesirable dip in the Pacific 
Ocean. Thankfully, that never happened although 
we did get soaked and salted. It took about six ours 
to reach a safe port to dock for the night. We had 
made it safely to the Whitsunday’s, home of Australia’s 
elite. The Whitsunday Islands were a haven for sun 
seekers and beach bums alike. The storm had almost 
disappeared by the next morning, not a breeze nor a 
single cloud in the sky. The swells had given way for a 
calmer waters, and somehow the journey back to dry 
land seemed laboriously slow. No wind to push the 
sails, no battering waves to set the heart pounding, it 
was relaxing but it made me realize that the trip over 
to the islands were exciting and definitely not scary by 
any means. Docking at Airlie Beach, our final trip up the 
west coast ended in Cairns, travelling on a Greyhound 
through the vast sugar plantations of Queensland. 

Travelling through Cairns was a humid affair. We 
did not spend too long there but I do remember we 
had to buy some supplies for the next part of our 
adventure. Walking along the street, we were looking 
for fly nets and some brimmed hats for the burning sun 
of the interior. Fly nets to the uninitiated are quite the 
fashion disaster but they do stop the flies from trying 
to get the moisture out of your eyes. Once we were 
sorted with those, the next objective was the hats. 
I am a stickler for mementos; there was a wonderful 
store in Cairns that specialised in bush hats and various 
other oilskin jackets and hats. I just had to have one, 
sorry to all ye’ anti-leather readers out there. I bought 
a well-stitched kangaroo hide soft leather Bush hat 
and I wore it with total pride. I still have it and I love it. 
The reason I still wear it is that it reminds me of where 
I was. It makes a great hat for fishing, it shades the sun, 
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shelters my mug from the rain and it gives me good 
luck some of the time. We spent one night in Cairns 
and then flew from Cairns to Alice Springs in the south 
of the Northern Territories. 

Alice Springs is a small, hot, and dry town right in 
the heart of Australia. It is a popular stopping point 
for visitors to Uluru or Ayers rock as it was previously 

known. For the first evening in Alice Springs, we took 
a camel ride out to watch the beautiful sunset. Camels 
are feral in Australia, roaming wild in the outback. A 
bumpy ride to say the least but from the lofty view 
from their humped back we could see dozens of Red 
Kangaroos, all bounding in rows at impressive pace 
too! Once our time in Alice Springs was up it was time 
to take a tour bus to the much loved and wrote about 
Uluru, a huge single mass of rock made sacred by the 
Aboriginal peoples. The tour bus was an interesting 
affair with the combination of a talkative bus driver 

and seats that reminded me of the hard seats of my 
school years, a bittersweet experience but definitely 
well worth it. It took a few hours to reach Uluru from 
Alice Springs although I believe we got there via the 
scenic route. It was getting late in the evening so we 
were searching the scrubland for dead wood for a 
campfire. That night around the campfire, we all sat 
around having some beers, and talked about generally 
anything. A hardened avid hiker from Norway was 
talking of his adventures in the European Alps and his 
long nights of sleeping out in the freezing cold. An 
interesting character, we hung onto his every word.

We all had the option of either sleeping outside 
in Swags or in a dark and dusty tarpaulin tent. Being 
tourists, the Swags were first choice for the lot of us - 
until the rain. It teemed down for hours. The hardened 
Norwegian bailed to the tent along with about seven 
of the ten or so people of the group. I however, was too 
stubborn and perhaps too lazy to move. The morning 
came, some clouds still lingering and it was early, at 
about five o’clock or so. It should also be noted that 
trying to extricate oneself from a soaked Swag is not 
easily done if you want to remain dry. We reached the 
base of Uluru by nine; to walk around it took well over 
an hour or two. After our Uluru adventure was over, it 
was time to move onto the Olga’s or Katja Tjita, another 
rock formation made sacred by the aborigines. It was 
mid afternoon by the time we reached Katja Tjita, so 
it was a hot hike up and around the site but I have to 
say that it was a truly wonderful experience to see first 
hand what is so precious to the Aborigines.

On the Same tour, we hiked around Kings Canyon, 
and the natural bowl that is Wilpena Pound. Towards 
the end of our central Australia tour, we moved south 
to a famous opal-mining town of Coober Pedy in the 
state of South Australia. Coober Pedy is known not only 
for its opal mines but for its homes also. The homes of 
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Coober Pedy are underground, carved out from the 
same rock as the miners do when digging for Opals. 
The intense heat of the summer moved the residents 
underground where the temperature is a constant and 
the heat of the midday sun cannot penetrate the rock.

By then we were down to our last week of our 
Australia adventure, the great ocean road is a long 
scenic route that runs along the coast of the state of 
Victoria, taking in the sites of the spectacular twelve 

apostles (of which I believe there are only nine of them 
left). The twelve apostles are a group of pinnacles 
carved by the Southern Ocean; each day little by little 
they fight a losing battle against the ocean. Knowing 
that Twelve Apostles will not be around for much 
longer makes me one of the lucky ones to have had the 
opportunity to see such a beautiful site. We camped 
in the Grampians, sleeping under the stars, watching 
the moon move slowly across the sky from dusk until 
the sun began to peer over the mountains the next 

morning. I had bought a proper didgeridoo in Sydney at 
the beginning of the trip so I had a little practice  before 
I mailed it home. When the guide produced a few PVC 
Didgeridoos (well it was actually like a pipe from the 
back of a toilet), I was thrilled with the excuse to show 
off my skills. Looking back, I reckon I probably sounded 
like a horse with bad wind. Every now and again, I take 
out the Didge and do a little practicing, although I 
think at present there are some house spiders residing 
inside it for some time now at this stage.

And so the final leg of the tour was over. It really was 
a fantastic trip, meeting lots of strange and beautiful 
people was a highlight as well as the fantastic scenic 
views and unique ecosystem with some of the most 
incredible flora and fauna on earth. I feel blessed that I 
was lucky enough to be able to visit such a wonderful 
place and I will go back there again some day to retrace 
my footsteps. 

Thinking back to Australia, it really was more than 
just Bush Hats, Dingoes, and Didgeridoos!

This article and all image contained are Copyright © are courtesy of Kenneth Fagan. Please contact the author directly with any questions.
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Back in the days of point and shoot cameras (before 
I had a digital SLR that is), I used to think that 
my trusty 512MB SD card was going to be more 

than enough memory for my 5.0 Megapixel camera. 
Afterall, I could fit hundreds of images on that card, 
and sometimes the space left on the card would even 
outlast the battery life between charges. Fast forward 
to the present and you’re likely to feel that no matter 
how large your memory card currently is, you’ll always 
find a need for more memory.

First, let’s have a look at the most commonly 
used types of memory cards currently on the market. 
You’ll want to check your camera to see what type of 
memory card it takes, and whether or not those cards 
are readily available, and in what sizes. Most digital 
SLR cameras on the market today will use either one 
of two popular formats: The CF (Compact Flash) card, 
or the SD (Secure Digital) card. Point and shoot camera 
memory cards come in all sorts of formats ranging from 
the aforementioned to other formats such as XD, and 
Sony’s MemoryStick. For the purposes of this article in 
relation to digital SLR cameras, we’ll examine the two 

most common formats: CF and SD (SDHC).

There are both pros and cons to either CF and 
SD cards, however, since your camera’s manufacturer 
makes this choice for you, I’ll keep the pros and cons 
list short. CF Cards are considerably larger in physical 
size. That could be considered a positive since they are 
more durable, robust, and slightly harder to misplace. 
CF Cards currently also have a larger maximum storage 
capacity, and faster write speeds. The SD (or SDHC - 
which we’ll get into in just a moment) cards are nice 
because they are much smaller, and consume less 
battery power from your camera when in use. It also 
really depends where you shop, but sometimes you’ll 
find cheaper prices on SD cards over CF cards. 

Currently, there are size limitations when it comes 
to the maximum amount of data that can be stored 
on a memory card, but fortunately the manufacturers 
keep coming up with larger (and faster) cards. At the 
time of this publication, CF cards currently come in a 
maximum data storage capacity size of 64GB, with the 
most common and popular sizes being 8GB or 16GB. 
SD cards have a maximum data storage capacity of 
2GB, however there is a newer breed of SD card called 
the SDHC (Secure Digital High Capacity) card. SDHC 
cards currently have a maximum size of 32GB but 
can theoretically go up to 2TB (terabytes)! The most 
popular current size for SDHC cards is 4GB to 8GB. The 
one caveat is that to use an SDHC card, your digital 
device (ie Camera AND card reader) must be able to 
read SDHC cards. An SDHC card looks identical to an 
SD card and will fit the same card slot size, but the 
device you are putting it into must be capable of using 
SDHC cards for them to work. 

Choosing the Right Accessories
With all of the photography gear on the market today, it’s difficult to 
determine which accessories are right for you, and what to look for once you 
decide on an accessory. In this ongoing segment, we’ll examine the things 
you should look for when choosing photography accessories, and help you 
to make an informed decision based on your photographic needs.

MEMORY MATTERS: SHOPPING FOR MEMORY CARDS - By Dave Seeram

As a digital camera owner (especially a Digital SLR camera owner), you’re bound to already be aware of what 
type of memory card your camera takes. From megabytes to gigabytes, SD to CF, not all memory cards are created 
equal... Or are they? This brief article will walk you through the ins and outs of memory cards - Something that 
(no matter what) you’ll never have enough of!
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The real question is: Is having the largest size 
memory card truly the best choice? That would be 
a personal decision I suppose. Most professional 
photographers (especially wedding photographers) 
would much rather carry a stack of 2GB memory cards. 
In the case that a memory card ever got lost or stolen, 
you wouldn’t lose your whole photoshoot. Price might 
also be a factor in choosing memory cards. Sometimes 
you’ll find sweet deals on lower capacity memory cards, 
as manufacturers stop producing them in efforts to 
make larger memory cards. You could easily buy four 
2GB cards for the same price (or sometimes less) than 
an 8GB card. 

Another factor to consider when shopping for size, 
is the data transfer. When you get home after a nice 
photoshoot, it takes a while to unload those photos! 
If you slap a 32GB memory card into your camera and 
go wild shooting until it’s full, that means not only do 
you need to have 32GB free space on your computer 
(which might be a stretch on some notebooks), but 
you also have to wait for your card reader to transfer all 
that data, which could take up to an hour!

Whether you are using CF, SD, or SDHC cards 
(depending on your camera), there are some things to 
consider when shopping for more memory. Let’s have 
a look at the important factors to consider:

Capacity: In my opinion, no matter what size you 
buy, you’re always going to want (or sometimes need) 
to buy more memory in the future. In the interest of 
getting the best bang for your buck, I find it’s a good 
idea to shop for memory card sizes which are on their 
way out. If 32GB is the newest size the store is selling, 
why not pick up a couple 8GB cards for now instead? 
They’ll be a bargain!

Speed: Write speed is something to consider when you 
have a digital SLR camera, and does not become too 
much of a factor with the point and shoot cameras. For 
most point and shoot cameras, even the slowest cards 
on the market will be adequate. When it comes to those 
nice big DSLRs though, you’ll want to invest a few extra 

bucks in a card with a faster write speed, especially if 
you work with RAW photos. Shooting in RAW means 
your photo’s sizes are going to be a lot larger than if 
you shot them as JPEGs. A faster write speed means 
faster time between shooting, and less lag between 
shots as your camera writes the data to the card after 
each photo is taken. Card Speeds are usually defined 
by a rating system in multiples of 150kb/s (kilobytes 
per second). Here’s a table of typical write speeds:

Brand: Does brand really matter? From personal 
experience I say 100% yes, brand does matter. Think 
about how important your photos are to you when you 
are shooting them. How would you feel if you went for 
a unique and wonderful photoshoot, only to find your 
files were corrupted, the memory card failed, and you 
lost all of those precious photos? Like anything else 
that you shop for, brand does matter when it comes to 
quality. Trust the larger brand names and manufacturers 
when it comes to memory cards. Afterall, the memory 
card could very well be considered THE MOST important 
accessory for your camera, especially after a shoot is 
complete. This is not to knock aftermarket products 
in general. I have purchased many aftermarket items 
which are as perfectly good as the “originals,” but I 
find when it comes to anything important (and usually 
electronic), it’s more wise to stick with a tried and 
trusted brand.

The last issue I wanted to touch on before I 
conclude, is the business of shopping online for camera 
accessories. Many of you are already shopping online, 
and so you should (with trusted retailers). You will find 
that for accessories (especially memory cards) you will 
find deals online that no brick and mortar store will 
ever be able to compete with. Why is that? Most online 
stores simply have less overhead costs, and competition 
online is stiff! This makes for great bargains for us the 
consumers. Browse the Shop PhotographyBB website 
sometime and you’ll see exactly what I mean. 
http://shop.photographybb.com

I hope this brief article has been useful in helping 
you the next time you are shopping for more memory. 
Happy Photographing!

Rating Speed (MB/s)

6x 0.9

32x   4.8

40x 6.0

66x 10.0

133x 20.0

150x 22.5

SD and SDHC Cards look the same, but are not always 
compatible to the same devices.

This article and photographs contained are Copyright © and courtesy of Dave Seeram. Please contact the author directly with any questions.
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The latest round of photographic tools enabling 
the photographer to deal with difficult scenes 
has come in the form of the digital darkroom. It 

is no secret that the digital darkroom has been a boon 
for all photographers, whether it is simple cropping or 
complete photo-surgery. HDR software packages have 
now brought to the table a whole new set of tools 
to help us potentially realize from the more natural 
to super-natural imagery. Now with regards to using 
these new tools there are a few techniques that need to 
be followed and an understanding of this will also help 
knowing what equipment will enhance this method.

Understanding HDR / tone mapping 
is easy. First the photographer must 
photograph a high contrast scene with 
two or more images that have different 
shutter speeds for each exposure. By 
doing this the camera’s sensor is able to 
capture different ranges of the dynamic 
range that it couldn’t otherwise handle 
in one image. Think of it like this, if your 
camera can capture 6 stops of dynamic 
range in a single image, but the scene 
you are photographing is comprised of 
12 stops of dynamic range, your camera’s 
sensor would miss 6 stops of the range. 
This is the dilemma of today’s cameras 
and display media; they all fall short on 
capturing and reproducing real world 
dynamic ranges that we all encounter.

So before we the photographer can utilize these 
new tools there are some important steps that need to 
be followed to ensure the best results… some of which 
most of you already may know, while a couple may be 
new. So here is my list of techniques and tools for HDR 
efforts and high contrast scenes: 

1. Bracketed Shots. As mentioned previously, you 
will need to capture at least two exposures (most 
folks use three to five exposures, while some use even 
seven or nine exposures!). There are several ways to 
achieve this. Foremost and the most effective way is 

FUNDAMENTALS ON EQUIPMENT AND TECHNIQUES FOR HDR - By Fred McWilson

High Dynamic Range (HDR)
HDR (High Dynamic Range) photography is a relatively new photography 
technique made possible by the advent of digital camera technology, and 
new breakthroughs in image manipulation software. This monthly series 
will take you through the basics of HDR photography, and how you can 
create your own stunning HDR images.

Welcome back to our series on HDR. In last month’s issue we learned what HDR/tone mapping is and some of 
the ways it can be used in photography. As a quick review, HDR or “high dynamic range” with regard to digital 
photography is the term used to describe high contrast scenes that have a dynamic range of light greater than 
your camera’s sensor can capture. As mentioned last month, there are several ways to overcome high contrast 
scenes and with the advent of the digital darkroom comes even more and sometimes much better solutions. This 
month we will focus on some of the more recent tools to battle high contrast scenes with respect to equipment 
and techniques.
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to use the “auto exposure bracketing” (AEB) feature 
on your camera if it has it. The “AEB” feature allows the 
photographer to adjust the camera’s exposure values 
between three or more exposures. So for instance, I 
can set my Canon 40D for three shots, one at normal 
ev and the other two anywhere from +-1/3 ev to +-2 
ev.  I typically set my camera for a -2ev, 0ev +2ev AEB 
which will automatically snap off the three images 
with the differing shutter speeds to give me the 
different exposure ranges I had chosen. I would also 
like to mention here that when bracketing your shots, 
only change your shutter speed and never change 
the aperture once everything has been set. If you 
change the aperture during the sequence of shots this 
changes your depth of field (DOF), and since we will 
be converging the images eventually, having different 
DOF’s will negatively affect the results. Only change the 
shutter speed once you begin your bracketed shots. 
Now, getting back to ways to capture your bracketed 
shots, another way is using the manual setting on your 
camera and manually adjusting the amount of ev by 
adjusting the shutter speed. For some point and shoot 
cameras this may be your only option if you don’t have 
the AEB feature available.

Let me interject a few thoughts on why AEB is your 
best friend for HDR work. Since we are photographing 
a scene multiple times with different exposure 
values, time becomes very critical. Most HDR scenes 
will contain objects that move such as clouds, trees 
and people. Once you begin trying to capture your 
scene you will soon understand that even minimal 
movements can cause issues such as “ghosting”. See 
the image (shown below) for a ghosting example. 
The best way to minimize such movements are first to 

wait for a perfectly still day and have no people in the 
scene…not very practical. Secondly, if you can’t wait 
for such perfect conditions, then trying to capture 
the images as quickly as possible becomes important, 

this is where AEB can help 
you out. AEB on most DSLR’s 
will automatically fire off 
the three or more bracketed 
shots as fast as the camera 
can go, in my case with the 
Canon 40D it is 6.5 frames per 
second. So theoretically I can 
capture three images within 
~1/2 of a second. So if it is a 
windy day and the clouds are 
zipping across the scene and 
the limbs of trees are swaying, 
I can usually catch a moment 
where the limbs come to a rest 
and fire off AEB sequence. It 
doesn’t always work but you 
have a much better chance 
of success than without AEB. 
Trying to manually adjust for 
each shot is just way too slow 
for this type situation.

When photographing an HDR scene which include people, AEB mode 
can help fire off quick exposures since your model will need to remain 
perfectly still for the sequence of shots.
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2. Tripod. Most photographers realize the importance 
of using a tripod to achieve the sharpest images 
possible. Well this still stands true for HDR photography 
but with an additional twist. As we learned above we 
will be capturing a scene multiple times, so a tripod 
not only helps with reducing camera movements 
(camera shake) but also will help maintaining image 
registration. Image regi-what?? Remember that not 
only are we capturing multiple images of a scene but 
later we will be combining these shots together to 
broaden the dynamic range. So by keeping the scene 
framed identically maximizes this combining process 
and provides the best possible finished results. Let me 
also mention that great HDR/tone mapped images 
have been created doing handheld shots but this is 
a secondary choice and limits you on the amount of 
ev you can choose. Since a lot of the times your HDR 
images will fall below the 1/60th of a second shutter 
speeds, a tripod really becomes more of a necessity for 
good sharp images.

3. ISO. The ISO setting for your camera if possible should 
be set to the lowest ISO setting possible. Without going 
into too much detail, when processing our images in 
one of the HDR packages, noise can sometimes be an 
issue since it can get magnified during the conversion. 
So to help minimize the noise issue it is best to use the 
lowest ISO setting such as ISO 100 speed.

4. Use RAW. For those who have the option of using 
their camera’s RAW format should do so. RAW format 
contains more image information than your good 
old jpeg file format. If your camera does not have this 
ability than make sure you use the highest resolution 
for your jpeg files.

5. Miscellaneous. Keeping in mind that the only 
changes we want between the captures are shutter 
speeds, so be sure to not adjust the white balance, 
focus, camera’s zoom or any other function between 
any sequences of shots. 

Finally, I want to walkthrough a typical HDR 
shooting session for those who may think this all too 
much work; it really isn’t once you get the hang of it. 

- First I determine the composition of my high contrast 
scene that I want and setup my tripod and camera.

- I check the above mentioned items such as ISO setting, 
RAW format and so on. 

- Next I go into my camera’s menu and turn on the 
AEB function and usually set it for -2ev 0ev 2ev, or two 
stops of ev spacing. Now if you do not have AEB, then 
just set your camera to manual and adjust the first shot 
for -2ev.

- Focus and compose the shot.

- Take the shots. If using AEB have the camera do it 
automatically. If using manual, once focus has been 
set, turn off auto focusing if it is on so it doesn’t refocus 
between any of the shots. Starting at -2ev snap the 
picture, then adjust to the 0ev and snap off another 
image. Lastly adjust the ev to 2ev and get the last 
image. It is also a great idea to use a shutter remote in 
conjunction with this effort.

That’s it!  You have generated your first set of 
images that can now be brought into your HDR 
software for the next step in creating a HDR/tone 
mapped image. So as a brief summary on fundamental 
HDR techniques, the key to creating great HDR/tone 
mapped images really begins at the capture level with 
your camera and following some of the above basics 
should get you going.

Lastly I just want to mention again the importance 
of AEB. Anyone looking into trying out HDR should 
consider before buying a new camera that it has AEB. 
I personally would only consider cameras that have 
this valuable feature. Here is a chart that gives you the 
specs of most cameras:
http://hdr-photography.com/aeb.html

Next month we will look at what to do with our 
multi-shot images so get out and start gathering some 
good shots to test out! 

This article and photographs contained are Copyright © and courtesy of Fred McWilson. Please contact the author directly with any questions.
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Panoramic Photography
With the advent of digital photography along with the image processing 
software tools which make up our digital darkrooms, panoramic photography 
is a fun technique in which you can create beautiful wide-view images. This 
month, we’ll have a look at how you can start shooting panoramic photos.

SHOOTING AND CREATING PANORAMIC PHOTOGRAPHS - By Rob Davidson

Shooting digital photographs has several  
advantages over film photography. The ability 
to manipulate the photograph, outside of a 

darkroom, has been one of the greatest advantages. 
Changing the brightness and contrast, altering colors, 
cropping and correcting faults has become much 
easier with digital photography. One of the things I 
enjoy is the ability to turn a standard format camera 
into a camera with panoramic format. I have never 
owned, or more importantly been able to justify the 
cost of a camera dedicated to taking panoramas. Now 
any digital camera can be used to create panoramic 
images with a few simple photographic steps and 
some post-processing on the computer.

Panoramic Images

Standard digital photographs have an aspect ratio 
of 4:3. That is in landscape mode, if the width of the 
image is 4” then the height will be 3”. This aspect ratio 
is great for most images as it get away from a square 
form but in many cases it may be limiting, especially 

when photographing landscapes. Our vision and the 
fact that we turn our head sideways means we tend to 
see wider than an aspect ratio of 4:3. 

Panoramic photographs, as I will describe, are 
for creating images that are wider than the standard 
camera format. The panoramic photo in Figure 1 
(Changing Sheds, Brighton Beach, Victoria, Australia) 
shows a good use of the extra width. This image is 
created from 2 landscape mode images. More than 2 
images can be used as in Figure 2 of the entrance to 
Sydney Harbour. Panoramic photographs generally 
provide an image with a width much greater than it 
height, but in some cases, height of the object might 
be something you want to show. Figure 3 (next page - 
bottom) shows the Pinnacles in Western Australia. The 
vertical format provides an alternative approach for 
the photography of 2 of the Pinnacles. The panoramic 
technique that I will describe can be used for images 
other than panoramic photographs. If you want to 
create a very high resolution image for printing or 
displaying on a very large canvas, then rather than 

Figure 1. Changing Sheds, Brighton Beach, Victoria, Australia. Shot with Olympus E-300, f/8.0, 1/160 sec, ISO 100, 21 mm focal length. 2 images stitched 
using A3DSticher
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limiting the technique to 1 row images for stitching, it 
is easy to extend this technique to multiple rows.

Photography

Landscape photography is the more common area 
for panoramas. When shooting it is often best to use 
techniques that maximize depth of field which has 
a corresponding increase in exposure time. Using a 
tripod is then recommended. 

The technique that you use to create panoramic 
images is that you take multiple overlapping 
photographs. It is recommended is that you overlap 
the 2 images by 25%. I have found that you can overlap 
by as little as 5 – 10% with good results. After selecting 
the landscape that I want to photograph, I then frame 
the first shot looking for some landmark towards the 
edge of the frame that I can then recognize to be on 
the edge of the second frame. The next technique 
I use is to ensure the horizon, if taking landscape 
photography, is going to be horizontal. A couple of 
practice movements of the tripod or the handheld 
motion will ensure that you have some good starting 

photographs. A pre-leveled tripod will help you pan 
the camera sideways.

 Using automatic exposures can mean that each 
frame varies in brightness. Varying brightness between 
images used to cause problems in stitching the frames 
together. Now all but the very basic techniques of 
stitching can adjust brightness and end up with uniform 
brightness in the final panoramic image. You no longer 
need to be concerned about varying exposures.

Differing focal depth between frames can be 
problematic. Landscape photography tends to have 
a high depth of field and uses a long focal length 
so is not usually a problem. If you use an auto-focus 
camera when focal depth can vary between frames, 
it is best set the camera on manual focus or use the 
camera features to maintain the focal depth between 
successive frames.

A complicating factor is motion in the frames of the 
photographs. Wave motion, as seen on the foreshore 
of Figure 4 (Busselton Jetty, Western Australia - next 
page) can be overcome by the software program that 
you use to stitch the image (more on this later). 

Figure 2. Entrance to Sydney Harbour, Sydney, Australia. Shot with Kodak DX6440, f/5.6, 1/750 sec auto mode, 5.5 mm focal length. 3 images stitched 
using A3DSticher

Figure 3. Pinnacles, Western Australia. Shot with Olympus E-300, f/4.3, 1/250 sec, ISO 100, 26 mm focal length. 2 images stitched using A3DSticher
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Capturing fast motion such as the boat in Figure 5 (Perth skyline from the Swan River, Western Australia) requires 
planning and minimizing the time between frames. Later image manipulation can overcome some small stitching 
problems.

Stitching the Images

Converting the frames to a final panoramic image needs some time in the digital darkroom. There are several 
approaches that can be used to stitch the frames together. All stitched images will need to be cropped and may still 
need brightness / contrast and other standard image processing manipulations. 

The most basic of the stitching techniques can be done using any digital image manipulation program. To do 
this, open the image frames and create a new blank image that is larger than the frames combined. Copy the frames 
into the new blank image and manually merge until they overlap as needed. The problem with various stitching 
techniques is that the original frames can not have been taken with wide angle lens as distortion at the edges of the 
frames will not match in size of shape of the objects in the image. The 35mm camera equivalent of a 50mm lens is the 

Figure 4. Busselton Jetty, Western Australia. Shot with Olympus E-300, f/8.0, 1/250 sec, ISO 100, 20 mm focal length. 2 images stitched using 
A3DSticher

Figure 5. Perth skyline from the Swan River, Western Australia. Shot with Olympus E-300, f/5.6, 1/640 sec, ISO 100, 80 mm focal length. 2 images stitched 
using A3DSticher
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widest that I would recommend for manual stitching 
techniques. Given that most panoramic images are 
taken as landscape photography, the original frames 
will more than likely be taken with wide angle lens, in 
which case this technique is not appropriate.

The next stitching method is to use a program 
such as Adobe Photoshop CS3. Photoshop has in-built 
functions that merge the frames, Auto-Align layers, 
then merges the brightness / contrast of the aligned 
image using the function Auto-Blend layers. The 
Photoshop stitching process corrects one of the frames 
to match the others objects. This process can be seen 
in Figure 6 (an old telegraph station on the Nullarbor 
Plain, Australia). These original frames are of different 
size (I deliberately cropped one image) and have had 
their brightness and contrast altered. As seen in the 
figure, the image on the left has been stretched on its 
right side to merge with the objects of the frame on 
the right. This technique works well. The web has many 
sites such as http://www.photoshopsupport.com/
tutorials/peter-bowers/how-to-stitch-photos.html that 
provide assistance with stitching in Photoshop.

Panoramic Software Tools

The next method is to use one of the many 
dedicated programs such as:

Panaview: 
http://www.panavue.com/

Autostitch:
http://www.cs.ubc.ca/~mbrown/autostitch/
autostitch.html

Autopano:
http://www.autopano.net/ 

Calico Panorama:
http://www.kekus.com/

A3DSticher: (which I have used for several years) 
http://wwww.anything3d.com/

There are many other such stitching programs; a quick 
search of the web will find them.

I have tried all of the above via trial version of the 
software. These programs typically have more features 
than are need for the simple landscape stitching. They 
also perform differently from methods described 
above. Rather than stretching one frame as per Adobe 
Photoshop, these programs correct for lens distortion 
prior to matching objects between frames. An example 
of this can be seen in Figure 7 (next page), where 
I used the same frames that were used in Figure 6. 
Auto exposure correction is usually built in with these 

Figure 6. Old Telegraph Station, Nullarbor Plain, Australia. Shot with Olympus E-300, f/4.4, 1/640 sec, ISO 100, 56 mm focal length. 2 images stitched 
using Photoshop. Notice how the left frame is distorted in order to align the matching features of the image in the other frames.
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programs. To me, the final panoramic image appears marginally better than the Photoshop image and much better 
than any manual methods. 

Some of the stitching programs have features such as the ability to build a complete 360° image and then are 
able to import these images into html (web pages) for viewing. Some stitching programs also have disadvantages 
compared to others. In some programs the images must be the same size horizontally and vertically before it will 
allow the stitching process to commence. I used the unequal size of 2 images to test for this. Not allowing unequal 
image size can be disadvantage. When I have had problems with motion between frames I have cropped one of the 
images. This then meant that I had to use another stitching program. Some programs can not stitch vertically. To 
overcome this I have had to turn the frames sideways prior to stitching and then re-oriented for correct presentation 
later.

Final Words

As with all photography, technical aspects are just a part of creating a great image. Composition, aesthetics and 
the story the photograph tells are more important. I enjoy my photography and stitching provides an alternative 
means of being able to display and enjoy my photographs. The best way to learn more is to experiment with your 
photography and stitching programs. I hope this article has inspired you to try out panoramic photography, and 
have fun with panoramic stitching.

About the Author

Rob Davidson is an Associate Professor and Head of Medical Radiations at RMIT University in Melbourne Australia. 
In his spare time he enjoys travelling around Australia and overseas and trying to capture interesting landscape 
photographs. 

Browse through the next page for some additional panoramic images from Rob. Enjoy!

Figure 7. Old Telegraph Station, Nullarbor Plain, Australia. Shot with Olympus E-300, f/4.4, 1/640 sec, ISO 100, 56 mm focal length. This method 
performed by dedicated panoramic image software corrects each frame for lens distortions prior to stitching them together, as seen above.
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Top: Narrows Bridge, Swan & Canning River, Perth, Western Australia. 2 
images stitched using Adobe Photoshop CS3.  Left: Pinnacles, Western 
Australia. 2 images stitched vertically using A3DSticher.  Right: Busselton 
Jetty, Western Australia. 2 images stitched vertically using A3DSticher

This article and photographs contained are Copyright © and courtesy of Rob Davidson. Please contact the author directly with any questions.
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Photoshop Actions in Action!
You’ve probably heard all about Photoshop® Actions by now, and maybe 
even downloaded a few. In this series, I’ll show you how you can create your 
own useful actions to automate those repetitive tasks. Save valuable time 
and energy with Photoshop Actions in Action!

DIFFUSING THE SITUATION - By Dave Seeram

Have you ever taken a nice portrait of someone, only to find too many distractions such as shiney zones on your 
subject’s face, or imperfections in the skin? If only there were a way to quickly remedy the problem? This month 
I am going to show you a digital “diffusion” technique which will give your images a smooth, soft, and higher 
contrast professional look, which are sure to “WOW” anyone who sees your portrait shots!

Since we have several Photoshop related tutorials 
this month with our Lightroom and Panoramic 
Photography articles, I am going to keep this 

one short and sweet. No need for fancy graphics or 
screenshots this time, just follow along in recording 
this action, and you’ll have a useful tool which you’ll be 
using to create a nice soft look in your portrait shots.

Step 1: Open an image, open your actions palette, 
create a new action (let’s call it “Diffusion”). Press 
record.

Step 2: Duplicate the layer (Command/Control-J), and 
change the blend mode of this new layer to “Screen.”

Step 3: Add a layer mask to this layer by going to the 
menu: Layer > Add Layer Mask > Reveal All

Step 4: Click on the thumbnail of the layer mask (in the 
layers palette) to make it active, and open the Apply 
Image tool (Menu: Image > Apply Image...). Make sure 
the following settings are: Layer: Merged, Channel: 
RGB, Invert checkbox UNchecked, Blending: Normal, 
and Opacity: 100%. Click OK, and your image should 
now have a bit of a glowing effect.

Step 5: Click on the image thumbnail of the top layer in 
the layers palette to deselect the layer mask. Now open 
the Gaussian Blur Filter (Menu: Filter > Blur > Gaussian 
Blur...). Increase the slider until you have an effect 
suitable for your image. Different resolution images 
wll require different amounts of blurring. Go subtle at 
first, until you find a setting you like. After you click OK 
in the Gaussian Blur dialog box, click inside the little 

box which is next to the checkbox in the “Gaussian 
Blur” step in your actions palette. This will stop the 
action at this point (every time you use it) so that you 
can manually adjust the Gaussian Blur, based on your 
image.

Step 6: Create a curves adjustment layer (using the 
“Create Adjustment Layer” tool at the bottom of the 
layers palette.

Step 7: When the curves dialog box appears, create a 
gentle S-curve (as we learned in issue 1 and 2 in our 
series on curves). This will create more contrast in our 
image, but it may intensify some of the colours, which 
we will deal with right now.

Step 8: Change the blending mode of the curves 
adjustment layer to “Luminosity” so that only the 
lightness values are affected by the curve, and not the 
colour values. 

Step 9: Your action is complete! Press the “Stop 
Recording” button in your actions palette, and give 
this action a test run on one of your photos.

I have also created a version with an optional Step 10, 
where I then added a Hue/Saturation Adjustment Layer 
checking the “colorize” box to ON. Also remember that 
you can adjust the opacities of any of the layers to 
lessen the effect.

Give this action a try not only on portrait photographs, 
but also on landscapes too. You’ll be able to produce 
surreal dreamy landscapes with this effect. Have fun!

This article and photographs contained are Copyright © and courtesy of Dave Seeram. Please contact the author directly with any questions.
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GETTING CREATIVE WITH ADOBE PHOTOSHOP® LIGHTROOM™ - By John Ogden

When version 1.0 of Adobe Photoshop 
Lightroom came out last year it revolutionised 
photographers’ workflow and picture 

enhancement, and made simple production tasks like 
adjusting levels, white balance, cropping and rotating 
much easier and more intuitive. Version 2.0 (which 
is in free beta right now!) is well placed to take this 
even further with selective editing.So we still need 
Photoshop proper for the more creative stuff, right? - 
Maybe not!

        
Black and White

At the very top of the basic panel on the right is 
the word “Grayscale.” This acts a button and clicking 
on it quickly produces a pretty good black and white 
version of your colour image.

Scroll down the basic panel and you will find 
that the HSL (Hue, Saturation, and Lightness) panel 
has defaulted to “Grayscale mix.” Fiddling with these 

sliders will change the tone (dark to light) of the area 
that corresponds to the slider’s colour in your original 
image. For example, the photograph of the Basingstoke 
Canal lock gates on the following page (taken in West 
Byfleet, Surrey, England), converts to a nice textured 
black and white image, but looses some brightness in 
the areas that were brown and green in the original. 
Pushing the orange and yellow sliders in the Grayscale 
mix panel to lighter tones shows how the composition 
can be improved.

This article will be exploring the more creative uses of Adobe Photoshop Lightroom version 1.0, and will push 
the boundaries to see just what “Photoshop” techniques can currently be achieved with Lightroom. Examples 
will include techniques such as selective colour and cross processing.

Adobe Photoshop® Lightroom™
Adobe Photoshop® Lightroom™ is Adobe’s latest tool for working with 
camera RAW  images, giving the digital photographer all the necessary 
tools to master their digital darkroom developing techniques. This series 
will explore various uses of Lightroom, and the types of processing and 
effects that can be achieved through working with RAW files.
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In another example, the originally red background in the image of English voice over artist Dan Powell can be 
made lighter or darker by adjusting the red slider in the grayscale mix.

Split tone

Right below the Grayscale mix is the “split toning 
panel” where you can experiment with settings to achieve a 
duotone effect, by adding subtle tones to the highlights and 
a different tone to shadows. A whole range of effects can be 
produced here from traditional sepia to more experimental 
warm, cool or combination tones.

The settings for the following examples on are shown in 
the table and images on the next page (The cool split-tone 
also has a generous “lens vignette” to add to the effect).
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Selective colour

As an alternative to hitting the automatic Grayscale button you can desaturate each colour in turn. True, it’s a 
bit more long winded, but leaves some creative options open. Try working with another colourful image, making 
sure you are in the saturation tab of the HSL panel, and take each slider down to zero in turn, then bring back just 

Split Tone Effect
Highlights Shadows

Hue Saturation Hue Saturation

Sepia 50 20 40 30

Warm 40 50 360 45

Cool 210 30 240 30
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one colour. The classic cars from the Orlando Old Town cruise are a great example. Here you can see use of selective 
orange, and another example where the blue sky has been reintroduced using the saturation sliders.

 

Cross-Process

When traditional film stock is purposely processed with the wrong chemicals the resulting image exhibits 
wild colour and contrast shifts. During the 1980s and 1990s, cross-processed images were very much in vogue. Try 
searching for fashion photographer “Nick Knight” in your favourite Internet image search engine to see some high 
profile examples.

In cross processed images 
contrast is usually high with blown-
out highlights, shadows tend toward 
dense shades of blue, reds shift to 
magenta (lips will appear almost 
purple, see the picture of model 
Lindsay from Liverpool, right), and 
the image highlights normally have 
a yellow-green colour cast. 

This look can be emulated in 
Lightroom’s develop module by 
combining some of the techniques 
introduced above. Try it yourself!

When working on a colourful image, pump up the exposure to just blow out your highlights then dial in a 
little on the blacks slider to bring back the contrast. Now find the split tone panel… WHAT? Split tone on a colour 
image!!! 

Yes! This is a perfect way to 
work those blues and yellows into 
the extreme tones. Choose a nice 
yellow tone for highlights and take 
saturation up to about 50% then 
similarly choose a cool blue for 
shadows and add 50% saturation 
here.

To finish off the look, use the 
Hue tab in the HSL panel and drag 
the red and orange sliders to the 
left towards magenta.

I hope this brief look into the 
more expressive side of Adobe 
Photoshop Lightroom has you 
hooked, experiment on your 
favourite images and get creative!

This article and all image contained are Copyright © are courtesy of John Ogden. Please contact the author directly with any questions.

Bio:
John Ogden is an award winning London based digital artist and photographer. John lectures on Photoshop CS3 and 
Lightroom to adult learners in Further Education. John is Pentax shooter, Adobe Certified Instructor and member of 
the National Association of Photoshop Professionals.
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Adobe Dreamweaver® Basics
In today’s age of digital photography, the modern photographer is finding 
that not only do they need to be a good photographer, but they need to 
know things like image post-processing techniques, and even basic HTML to 
create their digital galleries on the web. In this column, we’ll look at some 
basic steps in Dreamweaver for building your photo websites.

A LOOK AT THE FIRST STEPS IN CREATING YOUR WEBSITE - By Victoria Sargsyan

Step 1: Select the column which we created in last month’s tutorial (by clicking on it).

Step 2: Go to the menu: Insert > Media > Flash Button... 
Here you’ll be able to customize the look of your 
website’s navigation buttons. In this example I am using 
“Translucent Tab” and I encourage you to experiment 
with the options until you find a button style which 
you like. Under “Button Text” add the name of the page 
you would like to link to. For example, you may want a 
“Gallery” page to show your images, a “Contact” page 
with your contact details, an “About Me” page, and so 
on... It’s completely up to you which pages you want 
to create buttons for, although you haven’t created the 
pages just yet! It may be a good idea to think of how 
many, and what kind of pages you would like your site 
to contain, and then create blank html pages (the same 
way we created this page from our first Dreamweaver 
tutorial), being sure to name them appropriately (ie. 
contact.html, or about_me.html). Moving down the list, 
you can choose the font style and size for your buttons, 
the link location (page you want to link to - which you 
need to create),  the background colour behind your 
button (choose the same colour as the background 
colour of your webpage), and the name of the button 
image which will be created. For the “Target” option, 
leave this one blank for now.

Welcome back! As we continue our “Photographer’s” series on Dreamweaver®, this month we’ll be taking a look 
at how to add navigation buttons to your website. The navigation buttons will be used to navigate to different 
pages within your site (which you’ll create later). Navigate back to your Dreamweaver website folder, and let’s 
get started with this month’s Dreamweaver tutorial!
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For my button “Resume”, I am going to link to a page with my Resume on it, and this is what my button now looks 
like in my navigation column:

That’s actually all it takes to creating navigation buttons! I know what you may be thinking... What if you don’t like 
the pre-defined button styles, and you would rather create your own navigation buttons with your own colours and 
style? The rest of this tutorial will show you how you can do that with Photoshop Elements®, and bring those buttons 
back into Dreamweaver to use with your site.

Step 3: Select the next cell in you navigation table, and go to the menu: Insert > Layout Objects > AP Div... Choose 
an appropriate width and height (I am using W: 102px and H: 55px).

Step 4: Fire up Photoshop Elements® and open a new Elements file: File > New > Blank File (with W:102px and 
H:55px). You can fill the image with any colour that you would like (which will be the colour of the button you are 
creating). 

Using the Horizontal Type Tool, type the name of your button in the center of the image (I am using “Resume” again 
for this example).
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Step 5: Go to the menu: Window > Style and Effects > and choose any style you like by double clicking on it. Then 
go to the menu: File > Save As... and name your file, adding a 1 after it (for example, I am using the name “Resume_
Button1.jpg” in JPEG format). Important - Remember you need to save the buttons into the your site’s “images” 
folder! Now we are going to create the rollover button image!

Step 6: Go to the menu: Edit > Undo Apply Style... and now pick a different style for your button ( I will go with “Inner 
Ridge” style). Next, change the color of the “Resume” word simply by selecting the text with the Horizontal Type 
Tool, and changing the color.

Step 7: Save this file in the same manner as your first button, but this time name it with a “2” at the end (so mine 
becomes “Resume_Button2.jpg” being sure to save in JPEG format again).
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Step 8: It’s time to come back to Dreamweaver. Click inside the AP Div (where your button will go) and go to the 
menu: Insert > Image Objects > Rollover Image... where “Original Image” will be Resume_Button1.jpg and “Rollover 
Image” will be Resume_Button2.jpg. Check the preload rollover images checkbox “on.” For the “When Clicked” field, 
choose the particular page your site will navigate to when your button is clicked. In this case, you will have to make 
a resume page (and a landing page for each button you add to your site). This should be fairly easy now that you 
know how to create basic pages!

This is what it looks like now:

Step 9: The final step is to save your work, and you may now view your page in your Internet browser. That’s it for 
this month! Here’s a view of our website so far. It’s pretty bare at the moment, but it’s taking shape quite nicely! This 
should keep you busy for a little while as you create your buttons and landing pages for each navigation button. 
Have fun with it, and we’ll see you next month!

This article and all image contained are Copyright © are courtesy of Victoria Sargsyan. Please contact the author directly with any questions.

About the Author: Victoria Sargsyan is a member of NAPP (National Association of Photoshop Professionals) and is a talented 
graphic artist and web designer with over 15 years professional experience. To see more from Victoria, visit her website where you 
can check out her galleries and additional tutorials at:
http://www.viktoriyaimage.com 
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Photoshop Elements® Tutorial
As our Photoshop Elements reader base continues to grow, we’ve come back 
again with another tutorial specifically for the Elements users out there! 
Check out this month’s Elements tutorial on how to create a web frame not 
only to add style to your photos, but to allow you to “name” or “sign” your 
images too!

CREATING SIMPLE WEB GALLERY FRAMES WITH ELEMENTS: PART 2 - By Victoria Sargsyan

Last month we looked at how a simple frame can really bring out your images when displaying them in your 
online gallery. Simple frames are classic and subtle, but perhaps you would like a more fancy frame around your 
image? This month, we’re going to learn how to create a frame out of the image itself. This is a popular effect, 
and works great with certain landscapes, and is a also favourite for wedding photographers.

Step 1: Open Photoshop Elements and create a new blank file by going to the menu: File > New > Blank File... I am 
using a file size of 700px by 500px, which is a good size for displaying your photo on the web.

Step 2: Using the Cookie Cutter Tool (Q), draw a rectangle to fit inside your image, as shown below:
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Step 3: Fill the white area with black using the Paintbucket tool.

Step 4: Open one of your photos (whichever photo you would like to add a frame to).

Step 5: Go to the menu: Select > All, then go to the menu: Edit > Copy. You can now close this image.
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Step 6: Using the Magic Wand Tool (W), click on your black border. Next, create a new layer from the layers palette, 
and go to the menu: Edit > Paste Into Selection... You can now resize this image if necessary.

Step 7: Create another new layer in the layers palette, and this time move this layer (in the layers palette) to the 
bottom, underneith the other two layers. Go to the menu: Edit > Paste... (Elements still remembers the last copied 
file). You can now resize this image to fit within the frame you just created.
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This article and all image contained are Copyright © are courtesy of Victoria Sargsyan. Please contact the author directly with any questions.

Step 8: Select the top layer by clicking on it in the layers palette, and apply a Style and Effect such as Simple Pillow... 
You can even try things like blurring the frame, or slightly darkening/lightening it. We’re finished! Your custom frame 
is now ready. Have fun showing off your images and Elements skills in your web galleries, or share your results with 
us on the forums, we would love to see your work.

The final result is a unique frame which will definitely make people stop and look twice!
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What are the PhotographyBB Forums?
PhotographyBB Forums are a place for anyone and everyone with a keen interest in digital photography or image 
editing, to gather around and chat with each other, ask questions, post comments, and share photos. You’ll find things 
like Photoshop Tutorials, photo galleries, digital photography discussions and tips for improving your photography, 
along with fun stuff like Photoshop games, photography challenges and more! 

Although we are geared towards the beginner, you’ll find a lot of highly experienced users on our site, who are there 
simply because they love to share their knowledge and help others out. That’s what we’re all about at PhotographyBB 
- A place for the beginner to come and ask questions or post photos without intimidation. Consider us a good place to 
meet like minded folks and learn at “the friendly forum!”

The Photo Challenge:
With the release of this month’s Magazine Issue for July, we’re also releasing a new contest to inspire creativity and 
participation on the forums. Every two weeks you will be given a “Photo Assignment” to complete by going out and 
shooting a photo with an assigned theme. We want you to try and shoot something new, so no need to sift through 
your archives looking for a photo which fits the description - we want you to go out and have fun shooting!

The shooting assignments will go on for two weeks each, and you may submit as many photos as you like on the 
forums. The best images will be chosen by our Admin and Moderators, and will be featured in the following issue of 
the PhotographyBB Online Magazine. It’s all in the name of fun, participation, your creativity, and inspiring others to 
explore and grow through their own photography.

Happy Photographing, and we’ll see you on the forums.

Visit the PhotographyBB Forums and participate today!
http://www.photographybb.com/forum/

What’s Happening:
The PhotographyBB

Forums
PHOTOGRAPHYBB: PHOTO CHALLENGES COULD PUT YOU IN NEXT MONTH’S ISSUE!
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Have a Great 
Idea for a 

Photography 
Article?

We are looking for 
talented individuals 

who would like to 
expand their portfolios 

by volunteering to 
contribute articles to 

this e-magazine! If you 
are interested, we’d 

love to hear from you.

Topics of Interest are:

- Photography Techniques
- Photography on Location
- Photoshop Tutorials
- Hardware / Software Reviews
- Camera Equipment
- Member Spotlight
- Plus we’re open to new ideas!

To become either a regular 
contributing author, or even 
just for a one-time article, 
please email us at: 

magazine@photographybb.com

Introduce yourself, share your 
idea, and maybe we’ll see you 
in next month’s issue!

Step into the Spotlight!
Would you like to be featured in the PhotographyBB 
Online Spotlight on Member section? If so, please let 
us know at: magazine@photographybb.com

We’ll feature your photos, a small biography and write-
up about you, as well as links to your web gallery or 
photography related business. We all love photography 
and image editing, so let’s get to know each other!

Next Month’s Issue:
Issue 7 for August has some great things in store 
for you. Our HDR series continues, along with our 
growing tutorials section for Photoshop, Elements, 
Dreamweaver, and Lightroom!

Next Month in “Photography Around the World” we’ll 
be off to London for a fascinating photographic look of 
one of the world’s most interesting cities. Stay tuned 
for coming issues as we travel the globe!

This month we had a great series of tutorials, and next 
month gets even better. Next month we’ll dive deeper 
into Dreamweaver and the creation of your web 
gallery, along with additional Photoshop, Elements, 
and maybe even a Corel Painter Tutorial for you digital 
artists out there!

Discounts for Readers:
There are several coupons and discounts for our 
readers who may be looking to buy some photography 
related gear or software. Currently, there are AMAZING 
deals in the Shop PhotographyBB eBay Store, so please 
feel free to check them out! Also, for anyone interested 
in trying out HDR processing, you may be considering 
purchasing Photomatix. Visit our HDR Page: 

http://www.photographybb.com/hdr/

and use the coupon code: photographybb.com for a 
special discount.

Thank you for reading the PhotographyBB Online 
Magazine. We hope  you enjoyed it, and we’d love to 
see you again next month. If you have any questions or 
comments for us regarding this magazine, please feel 
free to email us at:

magazine@photographybb.com


